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Now Up-to-Date is a calendar pro-
gram that maintains your schedule, 
reminds you of upcoming events, and 
manages your to-do list. Now Con-
tact is a contact manager that gives 
you instant access to important 
names, telephone numbers and 
addresses. 

Both applications are integrated so 
you can link calendar and contact 
information. When used over a net-
work, these products enable you to 
share your information with others 
and schedule meetings with them. 

 

Online Help

 

This booklet provides a quick refer-
ence to the main features of Now 
Contact and Now Up-to-Date. For 
detailed information, consult online 
Help by choosing the desired option 
from the Help menu. In addition, you 
will need an Internet browser such as 
Microsoft Internet Explorer or, 
Netscape Navigator to view online 
help.

 

Note: Full documentation includes a User 
Guide in PDF format and HTML Online 
Help, which are included with your prod-
uct. You can purchase a printed User 
Guide for a nominal fee by visiting the 
Now Software website at: 
http://www.nowsoftware.com

 

Technical Support

 

You can access web-based Technical 
Support by choosing this option from 
the Help menu in either Now Up-to-
Date or Now Contact. 

 

Tool Tips

 

In addition to online Help, the but-
tons in the Toolbars display pop-up 
labels when you place the pointer 
over them.

 

I n t r o d u c i n g  N o w  U p - t o - D a t e  &  C o n t a c t

 

The Month View is the first view that you see upon opening a Calendar file.

 

Holiday: 
Use this 
date-
specific 
Event to 
make 
Holidays 
stand out.

Undated To-Do: Use to indicate non-
date-specific tasks. Appears only in the 
To-Do List and the List View.

Add 
graphics 
from the 
Graphics 
palette.

Sticky 
Note: Use 
for quick 
attention-
getting 
messages 
in the 
Month 

Meeting: Use to 
schedule a 
meeting on a 
specific day at a 
specific time.

Special Event:  
Use to indicate 
special occasions, 
like birthdays.

Banner: Use to 
indicate graphically 
an Event’s span of 
days.

Toolbar

Appointment: 
Use for a 
date- and 
time-specific 
Event.

Mini-month 
Calendars

To-Do List

 

The List View is the first view that you see upon opening a Contact File. 

 

Choose List Layouts from the Define menu to choose the columns of Contact 
information that you want to display. Create different Layouts for different needs.

 

Toolbar

Column headers 
indicate the type 
of data displayed 
in each column. 
Click a header to 
sort the list by 
that column. 
Shift-click other 
headers to add 
secondary sorts.

Status bar indicates how many of 
the total number of Contacts in 
your Contact File are currently 
being displayed.

 

To-Do/Call: Use to indicate a date- and 
possibly time-specific task you need to 
do, or a call you need to make.

 

Click a tab to filter the list by that 
letter. Type text into the text field 
to further filter the displayed list.
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To work with calendar Events: 

 

Launch the Now Up-to-Date applica-
tion. 

 

(You can easily launch Now Up-to-
Date at any time by choosing it from the 
QuickDay menu.)

 

To create an Event: 

 

Select a day and choose the name of 
the Event type you are creating from 
the Event menu, or click a new Event 
button in the Toolbar.  Type the title of 
the new Event and press Enter or 
Return to save the new Event in your 
Calendar File.

 

To move an Event: 

 

Drag the Event to the new day or time, 
or cut the Event and then paste it. The 
second method is useful if you need to 
move an Event to a date beyond the 
period currently in view. 

 

To set Event Preferences: 

 

Choose Preferences from the Define 
menu and choose the Event type for 
which you want to specify a default 
setting. 

 

To modify an Event: 

 

Double-click the Event or select it and 
press Enter. This opens the Event Info 
window (

 

❶

 

). The Event Info window 
is where you set or modify Event 
attributes. This includes setting the 
time of the Event, adding a descrip-
tion, attaching Contacts, or changing 
the Event’s Category, Priority, Repeat, 
Type, or Reminder setting. 

 

To attach a Contact: 

 

You can attach Contacts to any Event, 
so that when you are reminded of an 
Appointment, for example, you can 
see your Contact’s name, company, 
and phone number. Click the New 
Contact button and type the Contact 
information in the dialog box that 
appears. Click OK and this informa-
tion appears in the Contact field of the 
Event Info Window.

You can link events in Now Up-to-
Date to contacts in Now Contact, so 
that information and changes made to 
information entered in one applica-
tion appear in the other. 

 

See page 18 for 
information on linking Now Up-to-Date 
and Now Contact.

 

Working with Calendar Events

 

Click to find 
and attach 
linked Contacts

Type the name of the 
Event here

Click to 
schedule a 
meeting

Click to use the 
Date/Time picker 
for setting the 
date, and start and 
end times

Click to print this 
Event’s information

Choose the 
Category for the 
Event from this 
menu

Click to create 
a new Contact

Click and hold to drag 
this window larger or 
smaller.

Select this to block 
your time for other 
events while this Event 
is in progress

Specify the type of 
Reminder for the 
Event from these 
menus

Drag the bar up or down 
to adjust the size of the 
Attachments field

Set the repeat 
options from this 
menu

Click to stamp the date/
time in the text field or 
start the Timer for Calls

Click to hide 
weekends

Click to turn off/on 
text wrap in Event 
titles/descriptions

Click to turn on/off 
scrolling in Month/
Multi-Day Views

Click to 
schedule 
a meeting

Click to 
create a 
Call To-Do

Click to respond 
to meeting 
notices

Click to 
create a 
To-Do

Click to create 
an 
Appointment

 

This field displays text that 
you type or paste in

This field displays Contacts, documents, 
and web URLs attached to the Event 
and/or users invited to a meeting

 

Click to 
attach a 
file

Click to add 
a URL

 

❶

 

Calendar                   
Toolbar
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Now Up-to-Date lets you view your 
schedule in several different formats 
and time ranges. Select one of several 
views by clicking one of the view but-
tons in the Toolbar (

 

❶

 

✍

 

�

 

).

 

To-Do List

 

A To-Do List is available in all views 
except in the List and Year Views. 
Click the To-Do List button in the 
Toolbar (

 

�

 

) to display in a list To-Dos 
and Calls for the current day, Undated 
To-Dos, and any To-Dos and Calls 
marked Done.

 

�

 

Dragging an item in the To-Do List 
to a new location in the list changes 
the Priority setting of the item.

 

�

 

Dragging any Event from a calen-
dar view to the To-Do List changes it 
to a To-Do. 

 

�

 

Dragging a To-Do from the To-Do 
List to a cell in the calendar view 
changes the date of the To-Do accord-
ingly.

 

Calendar Layouts

 

To determine how Events appear in 
calendar views, click the Define Cal-
endar Layouts button (

 

�

 

) in the 
Toolbar to open the Calendar Layouts 
dialog box. Here you can change the 
font, size, and color of month and day 
names and day numbers. You can also 
change the font and size of Event titles 
and descriptions. To change Event 
color and style, open the Define Sets 
dialog box 

 

(see page 6)

 

. 

 

List View Format

 

To determine List View format, choose 
List Layouts from the Define menu. 
Here you can choose which types of 
Events and columns to display. 

 

Using the List View

 

You can edit items directly in the List 
View and select options in pop-up 
menus.

 

�

 

Clicking and dragging the top of 
the column moves the column. 

 

�

 

Clicking and dragging the line that 
separates the columns resizes a col-
umn. 

 

�

 

Clicking a column’s title sorts by 
the column.

 

V i e w i n g  C a l e n d a r  E v e n t s

 

Calendar Toolbar

 

 

 

❹❶ ❷ ❸ ❺ ❻ ❼

❶

❽

❷

❹

❺

❸

 

Week View

Month View

Multi-Day View

Go to date

Year View

Day 
View
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To determine which events appear in 
your calendar, use categories and sets . 
Assign an event to a category, select 
the category to appear in your calen-
dar’s current Set, and any Events 
assigned to that category will appear. 
Sets are useful if you want to filter out 
events or categories, or if you want to 
assign different colors to events.

 

Assign an Event to a Category

 

To assign an event to a category, dou-
ble-click an event to open the Event 
Info window 

 

(see page 4)

 

. Use the Cate-
gory pop-up menu to select the 
category for the event. We recom-
mend you place related events in the 
same category. 

 

Create a new Category

 

If an appropriate category does not 
exist for an event, create a category by 
choosing Categories from the Define 
menu and clicking New. 

 

Filter and/or color Events

 

With events assigned to various cate-
gories, you now have the option of 
filtering events in and out of view, 
assigning text color and style to 
events, and activating or deactivating 
the reminder for groups of events.

Choose Sets from the Define menu (

 

❶

 

) 
to open the Define Sets dialog box. 
Here you see a list of the categories in 
the current set. Those categories 
whose events appear in your calen-
dar’s current set are marked with a 
checkmark. 

To remove or add a category, click to 
the left of its name (

 

❷

 

).  Using Mac  
OS X, click to select it, then click again 
to place the checkmark.

Those with a clock icon to the right 
have the reminder activated. To deacti-
vate reminders, select the category and 
deselect the Receive Reminders check-
box (

 

❸

 

).

To change the color or style of event 
titles and descriptions, select the cate-
gory for all events in a category and 
then select the desired color and style 
(

 

❹

 

).

 

Organiz ing Events

 

❶

❷

❸

❹

 

Select this checkbox to receive 
reminders for Events in the selected 
Category. A clock icon appears next 
to the Category in the list.

List all available Categories. A 
checkmark indicates that the Events 
in the Category will appear in the 
current Set.

Click here to remove the checkmark 
and prevent the Category’s Events 
from appearing in the Calendar 
current set.

Name of the current Set
Displays information about the 
currently selected Category.

Copies, deletes or renames the 
current Set or creates a new Set

Select the text, color, and style for 
the Events in the selected Category
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You can make events public by assign-
ing them to a Public Category that 
resides on a Public Event Server. Sim-
ply connect to the Public Event Server, 
then include the appropriate Public 
Category in your current Calendar 
Set.

 

Note: See the Now Up-to-Date & Contact 
User Guide for information on setting up 
a Public Event Server.

 

To connect to a Public Event Server: 

 

1.

 

Choose Server Connections from 
the Define menu. The Server Connec-
tions dialog is displayed (

 

�

 

).

 

2.

 

Click the Add... button. The TCP/
IP dialog box is displayed (

 

�

 

).

 

3.

 

Enter the Server name, TCP/IP 
address, and Port number.

 

4.

 

When all the information is 
entered, click OK. The new server will 
be added to the Server Connection list.

 

To include a Public Category in 
the current Set:

 

1.

 

Choose Sets from the Define menu. 
Private Categories appear as well as 
the Public Categories from the Public 
Event Server to which you have con-
nected (

 

�

 

). 

 

2.

 

Click to the left of a Public Cate-
gory to include it in your current Set, 
then click OK.

 

To make an Event public:

 

1.

 

Double-click an Event to open the 
Event Info window.

 

2.

 

From the Category pop-up menu, 
choose a Public Category (

 

❹

 

). The 
Event is now available to other users 
who subscribe to that Public Category. 
If there is no appropriate Public Cate-
gory to place the Event you want to 
make public, you can create one. 

 

To create a Public Category:

 

1.

 

Choose Categories from the Define 
menu. The Define Categories dialog 
box appears (

 

❺

 

).

 

2.

 

Choose a Public Event Server from 
the Server pop-up menu.

 

3.

 

Click New. The New Category dia-
log box appears.

 

4.

 

Type the new Category’s name, 
description, and passwords (

 

❻

 

).

 

5.

 

Click OK, and then click OK again 
to save your changes.

 

Shar ing  Event s

 

Offline Editing

 

When you add a Public Category to a Set, the Public Events it contains are read 
into your Calendar file. As a result, if you disconnect from your network, the 
Public Events are still available to you for viewing and editing. You can modify 
and create Public Events while you are offline. When you return to the network, 
these changes are sent to the Public Event Server and reconciled automatically. This 
feature is particularly useful for mobile users.

 

 

 

❶ ❷

❹

❺

❻

❸

 

Categories are grouped 
according to the Server where 
they reside, divided by a 
separator line. Private 
Categories are listed first, 
followed by Public Categories.
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Now Up-to-Date takes the guesswork 
out of planning meetings by automati-
cally finding the time when everyone 
is available. To use this feature you 
must be connected to other users over 
a network with a Public Event Server 
running. 

 

Set-up for Group Scheduling

 

Choose Schedule Meeting from the 
Meeting menu. Click OK and Now 
Up-to-Date walks you through the 
setup process:

 

1.

 

Connect to at least one Public Event 
Server (make sure that you connect to 
the Server on your network that’s set 
up to support Group Scheduling).

 

2.

 

Set your user name, which identi-
fies you on the network so you can be 
invited to meetings.

 

3.

 

Include one or more Public Catego-
ries in your Calendar File, for posting 
meetings that you schedule.

 

4.

 

Add some network users, confer-
ence rooms and meeting resources to 
your Calendar File, so you can include 
them in meetings that you schedule.

 

Scheduling a meeting

 

When you’ve completed these steps, 
the Schedule Meeting dialog box (

 

�

 

) 
appears. (If you have already gone 
through the setup, you can schedule a 
meeting at any time by choosing 
Schedule Meeting from the Meeting 
menu.) Select the people you want to 
attend the meeting, where the meet-
ing will take place, and any resources 
that will be needed (overhead projec-
tor, TV, etc.). Just drag the people, 
rooms and resources into the box on 
the right (

 

�

 

). Use the “Opt” box at 
lower-right for optional attendees (

 

�

 

).

Next you need to find the best day and 
time to have your meeting. To do so, 
choose either Group View (

 

�

 

) or 
Auto-Pick (

 

�

 

).

When you have found the time for 
your meeting, click OK, then click OK 
again in the Schedule Meeting dialog 
box to book your meeting. People 
you’ve invited will be notified of the 
meeting (

 

❻

 

) and given the option of 
attending or declining.

 

Schedul ing Meetings

 

❶

❷

❹

❺

❻

❸

 

Click the Meeting Notices button 
in the Toolbar to open the 
Meeting Notices dialog box and 
respond to meeting invitations

 

Meeting Notices

 

When you are invited to 
a meeting, the text 
“check meeting notices” 
appears in the Calendar 
header and the Meeting 
Notices button displays a 
red arrow. Click the 
button to open the 
Meeting Notices dialog, 
select the desired 
meeting, then respond to 
the notification.

 

 

 

Auto Pick finds the first available time for 
you automatically by searching everyone’s 
schedule and listing the times it has found.

Attendance is optional 
for people listed here

Drag the names of people, 
meeting rooms, and 
resources from the list on 
the left to this box

Group View lets you look at 
the schedules of attendees 
graphically.
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The QuickDay component of Now 
Up-to-Date reminds you of any date-
specific Event as well as provides a 
menu of the day’s Events. The 
reminders and the menu appear even 
when Now Up-to-Date is not running. 

 

Setting Reminders

 

To set a reminder, double-click an 
Event to open the Event Info window. 
In the Remind section, select the 
amount of time, the type, and the 
sound for the alert (

 

�

 

).

 

Two types of Reminder alerts

 

In setting up a reminder in OS 8.6 or 
OS 9, you can choose between two 
types—an alert dialog box or a menu 
bar alert. Only the alert dialog 
reminder (

 

�

 

) is available under OS X.

An alert dialog box (

 

�

 

) provides 
options for snoozing the alert, dis-
missing it, editing the Event in 
question, deleting the Event, or 
launching Now Up-to-Date to view 
your schedule in more detail. You can 
dismiss or snooze this type of alert 
and then continue with your work.

The menu bar alert flashes a reminder 
in the menu bar without interrupting 
you. To dismiss this type of alert, click 
the flashing title in the menu bar or 
pull down the menu and choose 
Snooze or Dismiss.

 

Quick access to Events

 

The QuickDay Event menu (

 

�

 

) dis-
plays the current day’s Events and 
allows you to create new Events in 
Now Up-to-Date. To view more infor-
mation about an Event in QuickDay, 
choose the Event from the list. To 
open the Calendar file, choose “Open 
Now Up-to-Date.”

 

Setting QuickDay preferences

 

In OS X you can set QuickDay options 
from the QuickDay preferences panel 
in Now Up-to-Date (

 

�

 

). Using the 
three tabs in this preference panel you 
can turn QuickDay on or off, choose 
which items to display in the menu, 
and set default options for Reminder 
alerts. The same options are available 
in OS 9 and lower by opening the 
QuickDay control panel.

 

U s ing  Qu i ckDay

 

❶
❷

❹

 

Select the amount of 
time before a scheduled 
Event to receive a 
reminder alert, the type 
of alert, and the sound to 
accompany the alert.

Click to snooze 
the Event for 
the interval 
indicated 

Click to 
dismiss 
the alert 
message

Change the snooze 
time for this Event. 
You can change the 
default snooze time in 
the QuickDay panel of 
your Now Up-to-Date 
preferences.

 

❸
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Now Up-to-Date allows you to print 
out your calendar information in a 
variety of formats. Any of the avail-
able Views can be printed onto many 
different page sizes. 

 

To print your Calendar file:

 

1.

 

Open the calendar View you want 
to print. Modify the appearance of the 
view, if necessary, for the desired out-
put.

 

2.

 

Choose Print Options from the File 
menu.

 

3.

 

Use the pop-up menus in the 
upper-left corner to choose a different 
View, the page format, or different 
Event font and size (

 

❶

 

). A preview of 
the page appears in the preview box in 
the upper-right corner of the dialog 
box.

 

4.

 

Set the time range from the hour 
range pop-up menus and select or 
deselect “Draw gray background” if 
you are printing a Day or Multi-Day 
View (

 

❷

 

).

 

5.

 

Make changes to the appointment 
book settings at the bottom of the dia-
log box (

 

❸

 

) if you have selected an 
appointment book format.

 

6.

 

Set other options such as the type of 
headers and page orientation of the 
printed output (

 

❹

 

).

 

7.

 

Click Print. The Print dialog box is 
displayed (

 

�

 

).

 

8.

 

Specify the beginning of the period 
to print and the number of months, 
weeks, or days to print (

 

�

 

).

 

9.

 

Select other options such as the 
type of headers, page orientation, or 
returning to the Print Options dialog 
box. To print double-sided output, 
choose Manual Feed (

 

�

 

).

 

10.

 

Click Print. 

 

Note: For detailed instructions on printing 
your Calendar, see the Now Up-to-Date & 
Contact User Guide or Now Up-to-Date 
& Contact online Help.

 

Pr int ing Your Calendar

 

❶

❷

❹

❸

 

Page 
preview

 

❺

❻

❼

 

Your selected options are 
summarized here
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To create a new Contact, launch Now 
Contact, then choose New Contact 
from the Contact menu, or click the 
New Contact button in the Toolbar. 
The Detail View opens to a new Con-
tact record with blank information 
fields (

 

�

 

).

 

To enter Contact information:

 

1.

 

Click in the field where you want 
to enter information.

 

2. Type the desired information.
3. Press the Tab key to advance to the 
next field.
4. Repeat steps 2 and 3 until you’ve 
entered all of the Contact information.
5. Close the Detail View.
To modify an existing Contact:
1. In the List View, double-click the 
Contact to open the Detail View.
2. Click in the field where you want 
to modify information.
3. Modify the field’s information as 
desired.
4. Tab to the next field you want to 
modify or click directly in it.
5. Repeat steps 3 and 4 until you’ve 
modified the Contact as desired.

Automatic Data Entry
Information from existing Contacts 
may appear automatically in Detail 
View fields as you enter new Contact 
data in them (�). Now Contact 
searches your Contact file for match-
ing text and telephone numbers, and 
inserts it as you type. This makes typ-
ing the same information over and 
over again unnecessary.

Detail Layouts
You can vary the Detail View by creat-
ing different Layouts, which control 
formatting (fonts, styles, colors) and 
arrangement (size and placement of 
information blocks). To switch Detail 
Layouts, just choose the one you want 
from the Use Detail Layout submenu 
in the Window menu.

Modifying in List View
You can also modify many aspects of a 
Contact directly in the List View (�). 
Almost all text fields can be edited 
simply by clicking and typing; click 
on other fields to display a pop-up 
menu of available options.

W o r k i n g  w i t h  C o n t a c t s

❶

❷

❸

To modify Contacts in List View, click in a field and type the new information ...

... or choose an option from the pop-up menu that appears

Contact information already entered for other 
Contacts is automatically displayed as you type

If more than one address exists for the same 
company, a pop-up menu allows you to choose 
the correct address from the list

Enter 
name 
and 
address 
informa-
tion

Use the Toolbar icons to create new 
Contacts, Events, and documents

Note, Event, and document attachments appear in 
the log entries. Double-click an item to open it

Choose Custom Fields 
from the Define menu to 
customize these fields

Contact Keywords list. Click the green 
checkmark to choose keywords
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Using Categories
Now Contact lets you organize your 
Contacts by assigning them to Catego-
ries. You can group Contacts by their 
relationship to you (Business, Family 
and so on) and change the way they 
appear according to their Categories.

To assign Contacts to Categories:
� In the List View (❶), click over the 
Contact’s Category column and choose 
the desired Category from the pop-up 
menu that appears. (The Category col-
umn must be included in the current 
List Layout.)
� In the Detail View, choose the de-
sired Category from the Category pop-
up menu in the Category Header (❷).

To create or modify Categories:
1. Choose Categories from the Define 
menu. The Define Categories dialog 
box is displayed (❻).
2. Click New to create a new Cate-
gory, or select an existing Category 
and click Edit.

Using Keywords
Keywords let you identify Contacts as 
belonging to one or more distinct 
groups. Since a Contact can belong to 
only one Category at a time, but can be 
assigned as many Keywords as you 
want, Keywords work well for groups 
of Contacts that cross over between 
Categories. Public Keywords (❸)can 
be seen by all users who subscribe to 
the Public Contact Server and Cate-
gory where the Public Keywords are 
assigned.

To assign Keywords to Contacts:
� In the Detail View, choose the 
desired Keyword from the Keyword 
pop-up menu in the lower right-hand 
column of the Contact Log (❹).
� In the List View, select a Contact 
and choose Assign Keywords from the 
Contact menu (❺).

To define or modify Keywords:
1. Choose Keywords from the Define 
menu. The Define Keywords dialog 
box is displayed (❼).
2. Click New to create a new Key-
word, or click Edit to modify an exist-
ing Keyword.

Organiz ing Contacts

❶

❷

❹

❺

❻

❼

To assign a Category in the List View, click and hold 
in the Category field for the Contact, then choose 
the desired Category from the pop-up menu.

To assign a Category in the Detail View, choose the 
desired Category from the Category pop-up menu.

To assign a Keyword, 
choose it from the pop-up 
menu in Detail View, or 
choose Assign Keywords 
from the Contact menu.

Choose Categories or Keywords from the 
Define menu to create Categories or 
Keywords.

❸
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Now Contact lets you find Contacts 
quickly and easily. You can rely on the 
customizable finding preferences to 
help you search under the same crite-
ria each time, or you can specify every 
aspect of your search using more 
unique criteria.

To use the AlphaBar or QuickFilter to 
narrow your search, see the following 
page.

To perform a basic search:
1. Choose Find from the Find menu, 
or click the Find button in the List 
View or Detail View Toolbar. The basic 
Find dialog box appears (if the 
detailed Find dialog box appears, click 
the Less button).
2. In the search text field, type the text 
you want to search for. By default, 
Now Contact searches for Contacts 
whose Name or Company fields start 
with the search text.
3. Click Find. The current contents of 
the List View are replaced by any Con-
tacts matching your search text.
To perform a detailed search, 
click the More button (❶).

Using QuickFind
There may be times when you want to 
search for Contacts based on the Cate-
gories and/or Keywords you’ve 
assigned them. QuickFind lets you do 
just that by “filtering” the Contacts in 
the List View so that you see only spe-
cific Contacts and hide the rest.

To use QuickFind:
1. Choose QuickFind from the Find 
menu, or click the QuickFind button 
in the List View toolbar. The Quick-
Find window opens (❷).
2. In the Categories list, click the Cat-
egories whose Contacts you want to 
include in the List View.
3. In the Keywords list, click the Key-
words whose Contacts you want to 
include in the List View.
4. Close the QuickFind window.
The Keywords list operates in “All” or 
“Any” mode. “All” displays only 
those Contacts with all selected Key-
words, while “Any” displays Contacts 
with any of the selected Keywords.

F i n d i n g  C o n t a c t s  i n  N o w  C o n t a c t

To perform a detailed search, click More, then set your 
search criteria in the detailed find dialog (below)

❶

To perform a basic search, type the search text, then click Find

Select the 
field(s) in 
which you 
want to 
search for 
the text

Click to return to the 
basic Find dialog 
(above)

Choose an option 
to determine how 
your search text 
will be matched

Select an option to 
specify how the 
found Contacts 
will affect the 
current List View

Select an option to specify 
where Now Contact should 
search for the text

Click to search only 
the fields specified in 
the Now Contact 
finding preferences

❷
Click to select all 
of the Categories

Click to switch 
between “All” 
and “Any” mode

Select the Categories 
whose Contacts you 
want to include in the 
List View

Select the Keywords 
whose Contacts you 
want to include in the 
List View

Click to deselect 
all of the 
Categories



14

Using the AlphaBar
An easy way to narrow your search is 
to use the tabs in the AlphaBar (�). 
The AlphaBar is located just below the 
Toolbar in the Now Contact List View. 

To start your search, simply click any 
of the letter tabs or the number tab. 
Contacts will be searched using the 
first level of sort set in the column 
header and all Contacts starting with 
the selected letter (or any number, if 
the number tab is chosen) in that field 
will displayed. For example, if you 
sort by Company and click the “G” 
tab, all Contacts in Companies start-
ing with “G” will be displayed. 

Click the All tab to display all Con-
tacts in the Contact file.

To change search parameters, make 
changes in the Find dialog as shown 
on page 13.

Tip: To find all Contacts in your Contact 
file matching the letter in the selected tab 
(in any field), hold down the Option key 
while clicking the tab. To display all of the 
Contacts in your Contact File, Option-
click the All tab.

Using the QuickFilter text 
entry field
Use the QuickFilter text entry field 
(located to the right of the tabs in the 
AlphaBar (�)) to quickly search for 
Contacts containing a specified word 
or phrase. 

Only the Contacts currently being dis-
played in the List View will be 
searched. This allows you to further 
filter your list. 

Contacts containing a match in any 
field will be displayed.

Using the AlphaBar and QuickFi lter

❷

❶

Use the letter and number tabs in the AlphaBar to quickly filter your Contact list. 

Use the QuickFilter text field to search 
only those Contacts currently being 
displayed in List View. As you type, the 
list is updated. Continue typing additional 
characters until the Contact(s) you want to 
see have been found. 
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The Public Contact Server application 
included with Now Contact lets you 
share your Contacts with other net-
work users. This is useful if your 
Contact File contains a list of com-
pany employees or other names and 
numbers that your colleagues might 
find useful.

You share Contacts by assigning them 
to Public Categories that are stored on 
Public Contact Servers, rather than in 
your personal Contact file.

Note: See the Now Up-to-Date & Contact 
User Guide for information on setting up 
a Public Contact Server.

To connect to a Contact Server:
1. Choose Server Connections from 
the Define menu. The Define Server  
Connections dialog box appears (❶).
2. Click Add... button. The TCP/IP 
dialog box is displayed (❷).
3. In the fields provided, enter the 
Server name, TCP/IP address, and 
Port number. This information should 
be provided to you by the administra-
tor of the Public Contact Server.
4. When all the information is 
entered, click OK. The new server 
should now appear on the Server Con-
nection list.
Note: In the status column for the newly 
added server, “Never Updated” will be 
displayed until you close and reopen the 
Server Connections dialog.

Adding Public Contacts
1. Choose Categories from the Now 
Contact Define menu. (❸)
2. From the Location pop-up menu, 
choose the desired server. Choose Cat-
egories, click OK, then click Done (❹).

Making Contacts Public
To share one of your Contacts with 
others, just assign it to a Public Cate-
gory that appears in the Detail View 
Category pop-up menu (❺).

Modifying Public Contacts
When you make changes to a Contact 
in a Public Category, the change is 
updated across the network. Every-
one subscribing to the Public 
Category containing that Contact 
receives the updated information.

Shar ing  Contact s

Offline Editing
When you subscribe to a Public Category, the Public Contacts it contains are read 
into your Contact File. When you disconnect from your network (go “offline”), the 
Public Contacts are still available for you to view and edit. You can modify and 
create Public Contacts while you are offline. When you reconnect to the network, 
your changes are sent to the Public Contact Server and reconciled automatically. 
This feature is useful for PowerBook and iBook users. 

❶ ❷

❹

❺

❸

Choose the Categories of
Public Contacts that you want

to add to your Contact file.

Private 
Categories are 
displayed above 
the line in the 
pop-up menu, 
Public Categories 
appear below the 
line.



16

QuickContact gives you instant access 
to your important Contacts at all 
times, whether or not you’re running 
Now Contact. It displays a menu of 
Contacts (�) that you have selected to 
show, and also lets you quickly find 
any Contact.

Setting up QuickContact
By default, QuickContact displays 
information about a Contact when you 
choose that Contact from the Quick-
Contact menu. You can also set it to 
open Now Contact when you choose a 
Contact (OS 8.6 and OS 9 only), to dial 
the Contact’s telephone number or to 
copy the Contact’s essential informa-
tion to the Clipboard.

To set these and other QuickContact 
options in OS X, choose the QuickCon-
tact panel of the Now Contact 
preferences (�). In OS 8.6 and OS 9, 
change preferences in the QuickCon-
tact control panel.

To add Contacts to QuickContact:
� In the Detail View, select the Quick-
Contact checkbox in the Category 
Header. 
� In the List View, select the Contact 
and choose Add to QuickContact from 
the Contact menu.
Note: You must save your Contact File 
before the Contact can be displayed in the 
QuickContact menu.

Using QuickContact
Choose Find Contact from the Quick-
Contact menu to search for a 
Contact—the QuickContact Find dia-
log box appears (�). Choose New 
Contact to open Now Contact to a 
blank Detail View, where you enter 
new Contact information. Choose 
Open Now Contact to open your Con-
tact file.

Choose a Contact name from the 
QuickContact menu to display the 
submenu of information that you have 
chosen to display. You can configure 
QuickContact to perform different 
tasks when you choose a Contact; see 
“Setting up QuickContact” above.

Using QuickContact

❶

❷

❸
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Now Contact lets you print Contact 
information in envelopes, labels, 
address books and more. Using the 
built-in word processor, you can cre-
ate letters, faxes or “form letters” that 
contain personalized information for 
one or more Contacts.

Using Templates
Templates (�) are predefined text for-
mats that speed up Contact printing. 
Now Contact includes a number of 
preset templates, or you can create 
your own using the template editing 
tools; choose the type of template you 
want to create from the Template sub-
menu in the Define menu.

To print Contact information:
1. In the List View, select the Con-
tact(s) whose information you’re 
printing.
2. Choose Print from the File menu, 
or click the Print Contact button in the 
toolbar. The Print dialog appears (❷).
3. Choose Now Contact from the 
pop-up menu.
4. Click Select Template...  (❸).
5. Select the template that you want 
to use for printing (see “Using Tem-
plates” above).
6. Click OK.
7. Select the Now Contact printing 
options as desired. Click Printing 
Options… to set further options.
8. Click Print.
To create and print a letter or fax:
1. Choose New from the File menu.
2. In the dialog box that appears, 
select Letter or Fax.
3. From the Template pop-up menu, 
choose a template to serve as the basis 
for the document (see “Using Tem-
plates” above).
4. Click OK. Now Contact’s word 
processor opens (❹).
5. Choose Print from the File menu, 
or click Print in the word processor 
toolbar. The Print dialog box appears.
6. Select the Now Contact printing 
options as desired. If you’re sending 
the document to more than one Con-
tact, choose which Contacts to include 
from the Which Contacts pop-up 
menu.
7. Click Print.

Pr int ing  Contact s

❶

❷

❹

❸

Choose the type of 
Template you 
want to create or 
modify

Choose from 
preset templates 
for the selected 
template type

Click to change 
dimensions of 
selected template

Template 
thumbnail

Create, 
rename or 
delete 
templates

Click to add 
predefined text or 
graphics to the 
selected template

Word processor 
Toolbar

Text formatting 
tools
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Sharing information between Now 
Now Up-to-Date and Now Contact 
gives you the power and flexibility of a 
complete personal organizer. Contacts 
created in Now Up-to-Date automati-
cally appear in your Contact file, and 
Events created in Now Contact  
appear in your Calendar file, and. 
When you modify a linked Event or 
Contact in either application, it 
appears in both applications.

Now Up-to-Date links to your pri-
mary Contact file by default, and Now 
Contact links to your primary Calen-
dar file. You can set linking options 
from the Preferences window of both 
applications.

To create an Event in Now Contact:
1. In the Detail View, choose an Event 
type from the New Event submenu in 
the Contact menu. The Event Info dia-
log box is displayed (�).
2. Enter information for the Event in 
the appropriate fields.
3. Click the Link/Unlink Event button 
in the Toolbar.
4. Close the Event Info window. The 
Event appears in the Contact Log and 
in your Now Up-to-Date Calendar file.
To create a Contact in Now Up-
to-Date:
1. With an Event open, choose New 
Contact from the Contacts submenu in 
the Event menu (�). The New Contact 
dialog box appears.
2. Enter Contact information in the 
appropriate fields.
3. Select the Add to checkbox.
4. Click OK. The Contact appears in 
the Event Info window’s Contact field 
and in your Now Contact file.
To link Contacts to an Event in 
Now Up-to-Date:
1. In the Event Info window (�) for 
the Event, click the Find Contacts but-
ton in the Toolbar. The Find Contacts 
dialog box (�) is displayed.
2. Type the text to search for.
3. Click Find. A dialog box is dis-
played (�) listing all of the Contacts in 
your Now Contact file that match the 
search text.
4. Select the desired Contact(s) in the 
list and click Attach to Event.

Linking Calendar Events  and Contacts

❶

❹

❸

Contacts linked to the 
Event in Now Up-to-
Date

❷

Click to link this Event 
to your Calendar file 
in Now Up-to-Date

❷

In Now Contact, choose the 
Event that you want to attach 
to the selected Contact

In Now Up-to-Date, choose to find a 
Contact that already exists in your 
Contact file, or choose to create a 
new Contact



Mac intosh  Keyboard  Shor t cut s

Now Up-to-Date

Creating
New Appointment Command-N
New To-Do Command-T
New Undated Command-U
New Special Command-E
New Banner Command-B
New Contact Command-Shift-N
Duplicate Event Command-D
Paste Repeating Event Command-R

Finding
Find Text Command-F
Find Again Command-G
Find Original Command-=
Find Contact Command-Shift-F

Viewing
Open Event Info Window Command-E
Open Month View Command-M
Open Week View Command-K
Open Multi-Day View Command-I
Open Day View Command-Y
Open List View Command-L
Open Set Command-1 through 

Command 8
Go To Date Command-J
Duplicate Window Command--
Hide Event Command-H
Show Hidden Events Command-;
Zoom In Command-[
Zoom Out Command-]
Turn on/off Word Wrap Command-\
Mark To-Do/Call as Done Command-/
Open Now Contact Option-Double-click a 

Contact

Formatting
Define Sets Command-Option-S
Define Categories Command-Option-C
Define Calendar Layouts Command-Option-F
Define Layouts Command-Option-L
Define Preferences Command-Option-R
Define Server Connections Command-Option-N

Working with the Calendar File
New Calendar Command-Shift-N
Open Calendar Command-O
Close Calendar Command-W
Save Calendar Command-S
Quit Now Up-to-Date Command-Q

Now Up-to-Date

Creating
New Appointment Command-N
New To-Do Command-T
New Undated Command-U
New Special Command-E
New Banner Command-B
New Contact Command-Shift-N
Duplicate Event Command-D
Paste Repeating Event Command-R

Finding
Find Text Command-F
Find Again Command-G
Find Original Command-=
Find Contact Command-Shift-F

Viewing
Open Event Info Window Command-E
Open Month View Command-M
Open Week View Command-K
Open Multi-Day View Command-I
Open Day View Command-Y
Open List View Command-L
Open Set Command-1 through 

Command 8
Go To Date Command-J
Duplicate Window Command--
Hide Event Command-H
Show Hidden Events Command-;
Zoom In Command-[
Zoom Out Command-]
Turn on/off Word Wrap Command-\
Mark To-Do/Call as Done Command-/
Open Now Contact Option-Double-click a 

Contact

Formatting
Define Sets Command-Option-S
Define Categories Command-Option-C
Define Calendar Layouts Command-Option-F
Define Layouts Command-Option-L
Define Preferences Command-Option-R
Define Server Connections Command-Option-N

Working with the Calendar File
New Calendar Command-Shift-N
Open Calendar Command-O
Close Calendar Command-W
Save Calendar Command-S
Quit Now Up-to-Date Command-Q

Now Up-to-Date

Creating
New Appointment Command-N
New To-Do Command-T
New Undated Command-U
New Special Command-E
New Banner Command-B
New Contact Command-Shift-N
Duplicate Event Command-D
Paste Repeating Event Command-R

Finding
Find Text Command-F
Find Again Command-G
Find Original Command-=
Find Contact Command-Shift-F

Viewing
Open Event Info Window Command-E
Open Month View Command-M
Open Week View Command-K
Open Multi-Day View Command-I
Open Day View Command-Y
Open List View Command-L
Open Set Command-1 through 

Command 8
Go To Date Command-J
Duplicate Window Command--
Hide Event Command-H
Show Hidden Events Command-;
Zoom In Command-[
Zoom Out Command-]
Turn on/off Word Wrap Command-\
Mark To-Do/Call as Done Command-/
Open Now Contact Option-Double-click a 

Contact

Formatting
Define Sets Command-Option-S
Define Categories Command-Option-C
Define Calendar  Layouts Command-Option-F
Define Layouts Command-Option-L
Define Preferences Command-Option-R
Define Server Connections Command-Option-N

Working with the Calendar File
New Calendar Command-Shift-N
Open Calendar Command-O
Close Calendar Command-W
Save Calendar Command-S
Quit Now Up-to-Date Command-Q

Now Contact

Working with Contacts (List or Detail View)
New Contact Command-N
Delete Contact Command-K
Attach File Command-Shift-C
Mark Contact Command-M
Dial Contact Command-D
Email Contact Command-E
Switch to Now Up-to-Date Command-U

Working in List View
Open List View Double-click a Contact  

in List View, or press 
Command-L

Move to Next Contact Command-Right Arrow
Move to Previous Contact Command-Left Arrow
Move to First Contact Command-Up Arrow
Move to Last Contact Command-Down Arrow
Select All Command-A
Show/Hide List View Command-L
Close List View With List View active, 

press Command-W
    (Note: Closing List View closes the Contact File)
Print Selected Contact(s) Command-P
Switch to Now Up-to-Date Command-U

Working in Detail View
Open Detail View Double-click a Contact  

in List View, or select 
it and press Enter

Move to Next Contact Command-Right Arrow
Move to Previous Contact Command-Left Arrow
Move to First Contact Command-Up Arrow
Move to Last Contact Command-Down Arrow
Clear Field Info Command-B
Print Contact Info Command-P
Close Detail View With Detail View active, 

press Command-W
Switch to Now Up-to-Date Option-double-click an 

Event, or press 
Command-U

Working with the Contact File
Open Contact File Command-O
Close Contact File With List View active, 

press Command-W
Save Contact File Command-S
Quit Now Contact Command-Q



Windows  Keyboard  Shor t cu t s

Now Up-to-Date

Creating
New Appointment Command-N
New To-Do Command-T
New Undated Command-U
New Special Command-E
New Banner Command-B
New Contact Command-Shift-N
Duplicate Event Command-D
Paste Repeating Event Command-R

Finding
Find Text Command-F
Find Again Command-G
Find Original Command-=
Find Contact Command-Shift-F

Viewing
Open Event Info Window Command-E
Open Month View Command-M
Open Week View Command-K
Open Multi-Day View Command-I
Open Day View Command-Y
Open List View Command-L
Open Set Command-1 through 

Command 8
Go To Date Command-J
Duplicate Window Command--
Hide Event Command-H
Show Hidden Events Command-;
Zoom In Command-[
Zoom Out Command-]
Turn on/off Word Wrap Command-\
Mark To-Do/Call as Done Command-/
Open Now Contact Option-Double-click a 

Contact

Formatting
Define Sets Command-Option-S
Define Categories Command-Option-C
Define Calendar Layouts Command-Option-F
Define Layouts Command-Option-L
Define Preferences Command-Option-R
Define Server Connections Command-Option-N

Working with the Calendar File
New Calendar Command-Shift-N
Open Calendar Command-O
Close Calendar Command-W
Save Calendar Command-S
Quit Now Up-to-Date Command-Q

Now Up-to-Date

Creating
New Appointment Control-N
New To-Do Control-T
New Undated Control-U
New Special Control-E
New Banner Control-B
New Contact Control-Shift-N
Duplicate Event Control-D
Paste Repeating Event Control-R

Finding
Find Text Control-F
Find Again Control-G
Find Original Control-=
Find Contact Control-Shift-F

Viewing
Open Event Info Window Control-E
Open Month View Control-M
Open Week View Control-K
Open Multi-Day View Control-I
Open Day View Control-Y
Open List View Control-L
Open Set Control-1 through 

Command 8
Go To Date Control-J
Duplicate Window Control--
Hide Event Control-H
Show Hidden Events Control-;
Zoom In Control-[
Zoom Out Control-]
Turn on/off Word Wrap Control-\
Mark To-Do/Call as Done Control-/
Open Now Contact Option-Double-click a 

Contact

Formatting
Define Sets Control-Option-S
Define Categories Control-Option-C
Define Calendar Layouts Control-Option-F
Define Layouts Control-Option-L
Define Preferences Control-Option-R
Define Server Connections Control-Option-N

Working with the Calendar File
New Calendar Control-Shift-N
Open Calendar Control-O
Close Calendar Control-W
Save Calendar Control-S
Quit Now Up-to-Date Control-Q


